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Introduction

Phonology Assistant is a computer program for analyzing phonetic data.

The goal of this training course is for students to be able to explore phonetic data and search for evidence of contrast or complementary distribution for phonetically similar pairs of phones. The course does not teach everything students can do in Phonology Assistant.

The course does not teach phonetics or phonology—it assumes that students are trained field linguists or are taking this course as a part of a linguistics course.

How students will learn

In this course, students spend most of their time actually practicing the skills using realistic data.

Each training module teaches one or more learning objectives. The learning objectives are skills that most field linguists need to be able to do. A brief introduction explains why the skills are important and when to use them. The data consists of phonetic transcriptions in Sekpele, a language spoken in southeast Ghana. In each module, students follow the numbered steps and check their work using the screen shots. For more practice, they can do the exercises. When there are questions in the Student Manual, students can check the answers in a box on the same page.

How to use the training course

· Teach the course to field linguists in one or two days.

· Teach the course as a part of a phonology or field methods course.

· Provide guidance and feedback to students who take the course at their own pace.

For information about self-paced learning, see page 10.

If there is no instructor, a motivated learner can use this training course.

Opening course documents

The course includes a Student Manual and this Instructor Guide. To open a document (for example, Instructor Guide), do either of the following:

· On the Help menu of Phonology Assistant, point to Training, and then click Instructor Guide.

· In Windows Explorer, double-click the PA Instructor Guide.doc file.

By default, it is installed in the following folder:

C:\Program Files\SIL\Phonology Assistant\Training

For more information about course files, see page 11.

Prerequisites

Instructor prerequisites

To be able to teach this course effectively, we recommend that you have the following:

· Two years of cross-cultural teaching experience (or familiarity with the students’ culture).

· Experience teaching a training course.

· For information about prerequisite computer skills, see the next page.
We recommend that you have passed or exempted an Introduction to Computers and Introduction to Microsoft Windows course (or the equivalent).

· Ability to read phonetic transcriptions in the International Phonetic Alphabet (IPA).

· Ability to analyze phonetic data.

To prepare for the course, and then teach it, you need ongoing access to a computer with Microsoft Windows XP or Vista, Microsoft Word 2000 or later, and Phonology Assistant 3.0. 
To do Module FW, you need SIL FieldWorks.

Student prerequisites

Before students start the course, make sure they are able to do the following:

· Read phonetic transcriptions in the International Phonetic Alphabet (IPA).

However, students do not need to type IPA characters on the keyboard in this course.

· Analyze phonetic data.

The course does not teach phonetics or phonology. It assumes that students are trained field linguists or are taking this course as a part of a linguistics course.

· Compute totals of whole numbers (up to three digits).

· For information about prerequisite computer skills, see the next page.
We recommend that you make sure that potential students have passed or exempted an Introduction to Computers and Introduction to Microsoft Windows course (or the equivalent).

Prerequisites courses

For information about prerequisite courses, write to:

Phonology Assistant Training Course
Information Technology Services
JAARS, Inc.
PO Box 248
Waxhaw, NC 28173

E-mail address: Computer_Train_JAARS@sil.org

Student prerequisite computer skills

Before students start the course, make sure they are able to do the following:

· Point, click, double-click, and drag with the mouse.

· Click commands on menus and submenus.

· Right-click in a window, and then click a command on a shortcut menu.

· Scroll up or down, or to the left or to the right, in a window.

· Press key combinations (for example, Ctrl+Home).

· Click buttons and tabs in dialog boxes.

· Select items in lists and drop-down lists in dialog boxes.

· Select and clear check boxes in dialog boxes.

· Navigate to a folder in Windows Explorer or a dialog box.

· Create a new folder in Windows Explorer or a dialog box.

· Click hyperlinks in Help topics.

· Maximize, minimize, and close windows.

Learning objectives

Each training module teaches one or more learning objectives. The learning objectives are skills that most field linguists need to be able to do.

When students have finished the course successfully, they will be able to do the following.

	Objective
	Module

	Create new Phonology Assistant projects.
	Module SF and FW

	Add Standard Format data sources.
	Module SF

	Add FieldWorks data sources.
	Module FW

	Open Phonology Assistant projects.
	Module DC

	Sort and group records in word lists.
	Module DC

	Display fields in word lists and the Record View pane.
	Module DC

	Chart the inventory of consonant or vowel phones.
	Module CH

	Define sequences of phones as units.
	Module CH

	Search phonetic data for examples that match a pattern.
	Module SE

	Sort the results of phonetic searches to observe examples of contrast or indications of complementary distribution.
	Module SE

	Search for examples of contrast in identical environments.
	Module SC

	Search for examples of contrast in analogous environments.
	Module SC

	Chart the distribution of phones.
	Module XY

	Test hypotheses about complementary distribution.
	Module XY

	Use Help to learn more about Phonology Assistant.
	all modules


Course map

By default, you can teach the modules according to the order in the Student Manual.

If students need particular skills as soon as possible, they can learn according to the following course map. A course map XE "course map"  is a simple diagram of the dependency relationships between modules. Before students start a module, trace the lines from it back to Module SF. Make sure they have finished the prerequisite modules successfully. We recommend that you highlight each module on the course map when students finish it.
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Instructional method

We recommend that you teach each module using the following instructional method. If a module contains more than one objective, repeat the steps for each objective (skill).

1. Introduce the objective:

a. Tell the students what page to go to in the Student Manual. Tell them to read the supporting information preceding the procedure.

b. Read the objective to the students. In a way that is relevant and motivating to students, briefly explain why the skill is important and when to use it.

If this course is a part of a linguistics course, relate the skill to what students have learned about analyzing phonetic data.

c. Remind students to open the correct Phonology Assistant project.

2. If the instructor’s computer is connected to a screen projector, demonstrate the skill. Do the steps of the procedure in the Student Manual. Describe each step as you do it.

3. Tell students to do the steps of the procedure on their computers.

4. Tell students to do the exercise on their computers.

5. Give feedback to students. For information about practice and feedback, see page 9.

6. Option: If the instructor’s computer is connected to a screen projector, ask for a volunteer from the class to do the exercise. Ask for another volunteer to describe each step.

Important points for instructors

· Be brief in your comments about the skill, but take time to clearly demonstrate the skill, so that students have a good model to follow when they practice the skill.

· Make sure that students get to spend at least half of their time actually practicing the skill and receiving feedback.

· When students practice the skill, let them operate the computer at all times. Do not take over the mouse or keyboard on a student’s computer. Even in the rare case when you need to tell them what to do to solve a problem, let them do it.

Tips for instructors

· Give explanations from the front of the classroom (step 1 on the previous page). Set up the instructor computer behind the student computers, so you can observe students’ progress on their monitors and assist them as needed (steps 2 and 3). Walk around the classroom to give feedback to students when they practice their skills (steps 4 and 5).

· If you need to help the students relax, you can use culturally appropriate short stories, humor, and pictures. The course is an intense learning time, but you can provide some humor and fun.

· If there are several ways to perform a task, teach one method that is accurate and easy to remember, but not necessarily the fastest method. After the course, intermediate computer users can discover on their own how to accelerate their work using toolbars, keyboard shortcuts, right-clicking, and dragging with the mouse.

· If there are several ways to describe actions on a computer, teach terms that are consistent with training books and online Help for other programs that run on Microsoft Windows.

Practice and feedback

The recommended instructional method provides enough repetition for most students: They see each skill two times (steps 2 and 6 on the previous page) and do each skill two times (steps 3 and 4). If all students move from one module to the next at the same time, make sure that the course schedule provides ordinary students enough time to practice.

The exercises contain fewer procedural steps than the corresponding modules in the Student Manual, because they provide more practice for the same skills.

Most instructors know that practice makes perfect. But practice by itself is not enough—without feedback, students might learn to do the wrong thing in the wrong way at the wrong time.

· Adequacy feedback: Can the student perform the skill to the required standard?

Whenever possible in this training course, adequacy feedback consists of a screen shot of the result or an answer to a question. Students can check their own work.

Option: You can recommend that students ask other students to double-check their work.

· Diagnostic feedback: If the performance is not okay, what is the problem?

· Corrective feedback: If the performance is not okay, what can the student do to improve?

The module notes in this Instructor Guide tell you when you must provide feedback.

Although this training course does not have a formal test of competence, you can use the exercises as skill checks to determine whether the students have achieved the learning objectives.

For students to practice their skills after the course, make sure that they will have access to a computer with Microsoft Windows XP or Vista, Phonology Assistant 3.0, and at least one of the following programs: Toolbox, FieldWorks, or Speech Analyzer. The skills will fade away unless students keep them alive by using them in their work. Students will use it or lose it.
Self-paced learning

In self-paced learning, progress is controlled by a student’s own competence, not a class schedule. Every student takes enough time to achieve the objectives—no more and no less. Faster students do not need to wait until other students catch up. Slower students get enough time to practice the skills.

Instructor-led self-paced learning

· Introduce each module and demonstrate the skills.

· Give feedback when the student practices the skills.

· Check the work when the student does the exercise (see the Student Manual and the module notes in this Instructor Guide).

Independent self-paced learning

If there is no instructor, motivated learners can use this training course by themselves.

1. Read this Instructor Guide. You are your own instructor!

2. Make sure you have the student prerequisite skills (see pages 4 and 5).

3. Decide which learning objectives you need to be able to do your work (see page 6).

You can practice the skills you need when you need them.

4. Do the modules and any prerequisite modules (see page 7). Before you start each module, read the module notes in this Instructor Guide.

5. Carefully compare your work to the screen shots in the Student Manual.

For information about setting up a computer for the course, see page 13.

Files

Phonology Assistant projects

A Phonology Assistant project consists of several files all stored in the same folder. The name of the primary file in a project has a .pap extension.

Because the course includes realistic data, you do not need to take time to create data for students to practice the skills. If advanced students need to use the skills in their work as soon as possible, they can practice the skills using their data instead of doing the exercises.

The data consists of phonetic transcriptions in Sekpele, a language spoken in southeast Ghana.

· In Module SF, students create a new Sekpele 1 project.

· In Modules DC and CH, students open the Sekpele 1 project.

· In Modules SE, SC, and XY, students open the Sekpele 2 project.

· In Appendix AD, students open the Sekpele 3 project.

· To learn about program features that this course does not teach, students can open the Sekpele 3 project.

The Sekpele 2 and Sekpele 3 projects are installed with Phonology Assistant.

For information about the Sena 3 project that students can create in Module FW, see page 17.

When you start Phonology Assistant the first time on a computer, the program creates a Training Projects folder and copies the Sekpele 1, Sekpele 2, and Sekpele 3 subfolders into it.

· On Windows XP: My Documents\Phonology Assistant\Training Projects
· On Windows Vista: Documents\Phonology Assistant\Training Projects
Course documents and Zip file

· PA Instructor Guide.doc

· PA Needs Assessment.doc

· PA Student Evaluation.doc

· PA Student Manual.doc

· PaTrainingProjects.zip contains the Sekpele 1, Sekpele 2, and Sekpele 3 subfolders that Phonology Assistant copies into the Training Projects folder.

By default, the course documents and Zip file are installed in the following folder:

C:\Program Files\SIL\Phonology Assistant\Training
Preparing Before the Course

· To understand each potential student’s previous expectations of the course and experience with computers, send a copy of the Needs Assessment to each student at least a week before the course.

· Read the Student Manual and this Instructor Guide.

Setting up a classroom for the course

· A week before the course, confirm the classroom location.

· For each student, do the following:

· Print a copy of the following: Student Manual and Student Evaluation. Put the printout in a notebook binder, if desired. Because the Student Manual is for students to keep, they can write notes in it.

For information about printing on A4 paper, see page 23.

· Make sure there is a computer with Windows XP or Vista and Phonology Assistant 3.0.

To do Module FW, make sure SIL FieldWorks is installed on the computer.

For information about setting up computers for the course, see page 13.

· Make a nametag or place card or both.

· If desired, prepare an address information form for the course.

· Set up the classroom.

· Make sure you know how to adjust the classroom environment (for example, temperature, lighting, and sound) to minimize discomfort and distractions.

· We recommend that you set up the instructor computer behind the student computers, so you can observe student progress on their monitors and assist them as needed.

You must decide if it is culturally appropriate.

· If you intend to use a projector for the instructor’s computer, test it.

· If you intend to use a microphone and sound system, test it.

· In the appropriate places, put signs to direct students to the classroom.

Setting up computers for the course

Set up the classroom computers in advance or help students set up the computers.

The screen shots in the Student Manual show Phonology Assistant on Windows Vista. Phonology Assistant also runs on Windows XP.

The students will make sure that their work is similar to screen shots in the Student Manual. The screen shots often show only the relevant part of the screen.

What students see on their computer screen might not exactly match the screen shots. If you decide it is important for their screens to match the screen shots, set the following properties.

Microsoft Windows Vista or XP

1. Right-click an empty area of the taskbar, and then click Properties.

The Taskbar and Start Menu Properties dialog box appears.

2. On the Taskbar tab, select the Auto-hide the taskbar check box.

3. Click OK.

Microsoft Windows Vista

1. Right-click in an empty area of the desktop, and then click Personalize.

The Personalize appearance and sounds window appears.

2. Click Theme.

The Theme Settings dialog box appears.

a. In the Theme list, click Windows Vista.

b. Click OK.

3. Click Window Color and Appearance.

If the Appearance Settings dialog box does not appear, click Open classic appearance properties for more color options.

The Appearance Settings dialog box appears.

a. In the Color scheme list, click Windows Vista Basic.

b. Click OK.

4. Click Display Settings.

The Display Settings dialog box appears.

a. Drag the Resolution slider to 1024 by 768 pixels.

b. Click OK.

c. If a Display Settings dialog box appears, click Yes.

5. Close the Personalize appearance and sounds window.

Microsoft Windows XP

6. Right-click an empty area of the desktop, and then click Properties.

The Display Properties dialog box appears.

7. Click the Settings tab.

8. In the Screen resolution area, select 1024 by 768 pixels.

9. Click the Appearance tab.

10. Click Effects.

The Effects dialog box appears.

a. Select the Use the following method to smooth edges of screen fonts check box.

b. In the list, select ClearType.

c. Click OK.

11. Click OK.

Installing supplemental language support in Windows XP

For information about a problem that causes Phonology Assistant not to display some diacritics in the proper horizontal or vertical alignment relative to their base character, do the following:

1. On the Help menu of Phonology Assistant, click Phonology Assistant.

The Phonology Assistant Help window opens. It displays the Getting started topic.

2. In the Navigation pane at the left, click the Index tab.

3. In the Type in the keyword to find box, delete any text, and then type diacritics.

4. In the list below the box, double-click diacritics.

The Topics Found dialog box appears.

5. In the list, double-click Troubleshooting alignment of diacritics.

The Help topic appears in the pane at the right.

6. Read the topic. Follow the steps to make sure supplemental language support is installed.

7. In the Navigation pane at the left, click the Contents tab.

8. Close or minimize the Help window.

Phonology Assistant

· Most screen shots in the course show the Phonology Assistant window in the initial default size. The window might be maximized in Modules CH, SC, and XY.

· If students will do Appendix AD, make sure that a headset or set of speakers is connected to the computer. Test the audio output.

Starting the Course

1. Before the students arrive, do any of the following:

· Adjust the classroom environment (for example, temperature, lighting, and sound) to minimize discomfort and distractions.

· If you use a projector for the instructor’s computer, test it again.

· If you use a microphone and sound system, test it again.

· If there is a special user name and password, start the student computers, and then log on.

· If there is a blackboard, whiteboard, or flip chart, write Phonology Assistant, a list of objectives (skills) or course map, and the course procedures.

· Put the printouts and place cards where you would like the students to sit.

Based on the Needs Assessment or your knowledge of the students, you might decide to set up the place cards so students who are beginning computer users sit near students who are more experienced computer users. Students can usually help others.

We recommend that you emphasize the group approach to learning, that working together helps everyone learn. The group approach to adult learning differs from traditional schooling. Make sure what you do is appropriate to your students’ culture!
2. Ask all the students to briefly introduce themselves and tell why they are taking the course.

If desired, tell the students to fill out an address information form.

3. Briefly introduce yourself.

4. Tell the students to turn to the Introduction in the Student Manual. Briefly explain:

· The goal and objectives of the training course.

As you teach, we recommend that you refer to the list of objectives or course map on the board (if available). Use it to review what the students have learned during the course.

· How they will learn during the course (that is, the instructional methods you will use).

If the Phonology Assistant course is part of a linguistics course, do the instructional methods differ from the main course?

· Course procedures, including the course schedule and rules for the course location (for example, when the building opens and closes, whether name tags are required, where to go if there is a fire alarm).

5. Tell students that they can write feedback on the Student Evaluation form during the course.

Teaching the Modules

Before the course, read all of the following module notes.

After starting the course, teach the modules according to the Contents in the Student Manual or the course map in this Instructor Guide (see page 7).

Before you start each module, review the notes about that particular module.

Module SF: Adding a Standard Format Data Source

· Explain that Sekpele 1 is a simple project. Most people need to learn the skills in Module SF, even if some people will need to set up more complicated projects for their work.

· In the context of a training course, there are reasons for multiple Sekpele projects. Field linguists do not necessarily need more than one project for a particular language.

· Make sure that students can start and exit Phonology Assistant.

· Encourage students to learn to use Help. The course does not teach everything students can do in Phonology Assistant. After the course, students can use Help to learn more.

Explain to students that if they click the Index tab of the Help window, you recommend that they click the Contents tab before they close the window. Otherwise, the Contents tab will not be active the next time the Help window appears. Even when a student clicks the Contents tab, it will not display the context of the initial topic. To display the context, a student can click a hyperlink in the Topic pane, and then click Back on the toolbar.

· Tell students to make sure that their work is similar to the screen shots in the Student Manual.

What they see on their computer screens might not exactly match the screen shots. For information about setting up computers for the course, see page 13.

· When students navigate to the Sekpele 1 folder, make sure that they navigate to the Phonology Assistant folder that is in the My Documents folder or in the Documents subfolder of their personal folder, not to the Phonology Assistant folder that is in the C:\Program Files\SIL folder.

Here is the path to the folder on Windows XP or Vista, respectively:

· My Documents\Phonology Assistant\Training Projects\Sekpele 1
· Documents\Phonology Assistant\Training Projects\Sekpele 1
Module FW: Adding a FieldWorks Data Source

· If FieldWorks is not installed on the computers or if students will not use FieldWorks data in their own work, you can tell them to skip Module FW.

· Explain that Module FW is limited to practicing the process of adding data sources, because the Sena 3 project does not actually contain phonetic data in the lexeme field.

· Make sure that students can navigate to the Training Projects, and then create a new Sena 3 subfolder.

Module DC: Viewing a Phonetic Data Corpus

· Explain that Module DC teaches basic data management skills that students will use in the rest of the course and in their own work.

· Explain that students will be able to use the skills that they learn in Module DC and the rest of the course, no matter which types of data sources they use in their work.

· Make sure that students open the Sekpele 1 project.

· Remind students to make sure that their work is similar to the screen shots in the Student Manual.

· Tell students to answer the questions in the Student Manual, and then read the answers that are in a box on the same page.

· Make sure that students can recognize which column in a word list is the primary sort field and whether it is sorted in ascending or descending order.

· Sometimes the Student Manual provides multiple ways to perform a procedural step (for example, menu, toolbar, and keyboard shortcut). Encourage students to try the alternatives when they practice the skill in the exercises and in other modules. In their own work, they can use the way that is accurate, easy to remember, and convenient for them.

· Make sure that students understand when to click and right-click in a column heading.

· Click any column heading in a word list to make it the primary sort field.

· Click any column heading to change to ascending or descending order.

· Right-click the Phonetic column heading to select sort options.

Module CH: Displaying Consonant and Vowel Charts
· Explain that the rows and columns in Consonant Chart and Vowel Chart views are, for the most part, consistent with the International Phonetic Alphabet (IPA) charts.

The views are “phonetic workcharts” that field linguists can use to identify phonetically similar phones in a language to analyze for potential contrast, complementary distribution, or free variation using skills that they will learn in Modules SE, SC, and XY.

· Make sure that students open the Sekpele 1 project.

· Typing IPA characters in the Unicode character encoding on the keyboard is outside the scope of this course. For information: on the Index tab of the Help window, delete any text in the Type in the keyword to find box, type keyboards in the box, and then double-click keyboards in the list below the box.

· Remind students to answer the questions in the Student Manual, and then read the answers that are in a box on the same page.

· Make sure that students can click two times (not double-click) in cells in the Ambiguous Sequences area in Phone Inventory view.

· Make sure that students press Ctrl+Shift+C to copy the selected phone in the Phone List area. If a phone and a number appears when they paste, they pressed Ctrl+C to copy.

· Make sure that students successfully enter and apply the changes in Phone Inventory view.

· Explain that in this training course, they learn skills in an order that makes efficient use of their time—not necessarily in the same order that they will apply them in their work.

Field linguists would not necessarily apply all the skills in Module CH at the same time.

When students finish Module CH, they have finished about 40% of the course.

Remind students to take a few minutes to give feedback on the Student Evaluation form.

Module SE: Searching Phonetic Data
· Explain that Module SE teaches basic searching skills that students will use in the rest of the course and in their own work.

Be prepared to answer questions from students about the notation for search patterns in Phonology Assistant. If this course is a part of a linguistics course, relate the notation to what students have learned.

· Make sure that students open the Sekpele 2 project.

· If the Current Search Pattern box ever stops responding—for example, students cannot click in the box, move the insertion point, or type in the box—remind them of this solution:

Minimize the Phonology Assistant window, restore or maximize the window, and then click in the Current Search Pattern box.

· Make sure that students click Clear or New Tab on the toolbar, when the steps in the Student Manual tell them to.

· Make sure that students can open and close the Phonetic Sort Options drop-down box.

· When students change the search options, tell them to follow the steps carefully. It makes a difference where they click in Search view after the change. If the current search pattern changes, it is likely that they unintentionally clicked a search result tab.

· If students cannot find phones in the preceding or following environment, the records might not be sorted by the Phonetic column. They might have clicked another column heading.

· When the Student Manual tells students to add Sekpele 2 plural nouns.db as another Standard Format data source and map Standard Format markers, make sure they do it successfully. The additional data source also affects Modules SC and XY.

When students finish Module SE, they have finished about 70% of the course.

Remind students to take a few minutes to give feedback on the Student Evaluation form.

Module SC: Searching for Contrast
· Explain that Phonology Assistant can help field linguists search for examples of contrast, but they must apply their understanding of phonetics and phonology to decide whether minimal pairs are relevant and whether analogous environments are adequate.

Be prepared to answer questions from students about contrast. For example, how phonetically similar do “suspect pairs” and analogous environments need to be?

If this course is a part of a linguistics course, relate the skills to what students have learned.

· Make sure that students open the Sekpele 2 project.

· If students need to display more of the search results, make sure that they can maximize the Phonology Assistant window and undock (hide) the Patterns & Pattern Building panel.

· Make sure that students select the correct combinations of minimal pairs and phonetic sort options for analogous environments (that is, identical preceding and identical following).

· If students cannot find the contrasting records, tell them to verify that the records are sorted by the Phonetic column. They might have accidentally clicked another column heading.

· If all students move from one module to the next at the same time, make sure that the course schedule provides ordinary students enough time to practice.

Searching for contrast takes more time than most other skills in this course. Explain that the methods in this module might seem inefficient because students find only a few examples of contrast (for the time that they spend). The methods will be much more efficient in their own work if the phonetic data corpus has at least 500 records.

Module XY: Searching for Distribution Patterns

· Be prepared to answer questions from students about distribution of phones.

If this course is a part of a linguistics course, relate the skills to what students have learned.

· Make sure that students open the Sekpele 2 project.

· Make sure that students can do the following in the Charts & Chart Building panel:

· Scroll to a particular tab.

· Scroll to a particular phone or feature under a tab.

· Click boxes two times (not double-click) on the Bin. Features tab.

· Double-click binary feature names (not the boxes) to insert them in the chart.

· If students need to display more of a chart, make sure that they can maximize the Phonology Assistant window and scroll in the chart.

· Make sure that students can double-click the dividers at the right of the column headings to increase or decrease the column widths to best display the search environments.

· If students make mistakes entering search items or environments, they can click, and then edit in the cells at the left and upper edge of a chart. For your information, in case students ask, they cannot insert a row or column in the middle of an XY chart.

· Encourage students not to lose sight of the purpose of verifying results in charts. They do not need to become accountants to use XY Charts!

We recommend that they include general and specific search items and environments in charts, as illustrated in the module, to make sure that results are consistent.

When testing hypotheses about complementary distribution, it is important to be confident that a non-zero or zero result in a cell is correct—that there truly are or are not records that match the search item and environment.

Appendix AD: Playing Audio Data

· If headsets or sets of speakers are connected to the computers, students can compare phonetic transcriptions to the corresponding audio data.

Appendix PS: Understanding Phonetic Sort Options

· Encourage students to read this appendix, if they have not already read it during the course.

Appendix CU: Cleaning Up Your Computer

· After students have finished the entire training course, give them time and assistance to clean up what they did in certain modules.

· Tell students to complete the Student Evaluation form and return it to you.

Cleaning Up After the Course

· Clean and straighten the room: pack up any course supplies and clean the boards.

· If you set up computers for the course, you can restore some properties (see page 13).

· If required, remove Phonology Assistant from all the computers on which it was installed.

· Log off or shut down classroom computers.

Request for feedback from instructors and self-paced learners

Your feedback about this course is important to Information Technology Services.

Send your feedback to the following address or e-mail address:

· Phonology Assistant Training Course
Information Technology Services
JAARS, Inc.
PO Box 248
Waxhaw, NC 28173

· E-mail address: Computer_Train_JAARS@sil.org
Subject line: Feedback about Phonology Assistant Training Course

Appendix A4: Printing Documents on A4 Paper

To print course documents on A4 paper XE "A4 paper size" 

 XE "paper sizes"  and keep the same page breaks XE "page breaks" , modify the margins XE "margins"  to keep the same content area (that is, width 6.5 inches and height 9 inches).

Microsoft Word 2007

1. On the Page Layout tab, click the dialog box launcher in the Page Setup group.

The Page Setup dialog box XE "Page Setup dialog box"  appears.

a. Click the Margins tab.

b. In the Top, Bottom, Left, and Right boxes,
enter the values from the following table.

	Boxes
	Millimeters
	Inches

	Top, Bottom
	34.0 mm
	1.34"

	Left, Right
	22.3 mm
	0.88"

	Header, Footer
	21.3 mm
	0.84"


c. In the Apply to list, select Whole document.

d. Click the Paper tab.

e. In the Paper size list, select A4.

f. Click the Layout tab.

g. In the Header and Footer boxes,
enter the values from the preceding table.

h. Click OK.

2. Click the Microsoft Office Button.

3. At the bottom of the menu, click Word Options.

The Word Options dialog box appears.

a. In the left pane, click Advanced.

b. In the Advanced Options for Working with Word pane, scroll down to the Print section.

c. Clear Scale content for A4 or 8.5 x 11” paper sizes.

d. Click OK.
4. To update the fields in the document, press Ctrl+A, and then press F9.

5. If the Update Table of Contents dialog box appears, click Update entire table, and then click OK.

6. Always save the document before you print it.

Microsoft Word 2003 and earlier

1. On the File menu, click Page Setup.

The Page Setup dialog box XE "Page Setup dialog box"  appears.

a. Click the Margins tab.

b. In the Top, Bottom, Left, and Right boxes,
enter the values from the following table.

	Boxes
	Millimeters
	Inches

	Top, Bottom
	34.0 mm
	1.34"

	Left, Right
	22.3 mm
	0.88"

	Header, Footer
	21.3 mm
	0.84"


c. In the Apply to list, select Whole document.

d. Click the Paper tab.

e. In the Paper size list, select A4.

f. Click the Layout tab.

g. In the Header and Footer boxes,
enter the values from the preceding table.

h. Click OK.

2. On the Tools menu, click Options.

The Options dialog box appears.

a. Click the Print tab.

b. Clear the Allow A4/Letter paper resizing check box.

c. Click OK.

3. To update the fields in the document, press Ctrl+A, and then press F9.

4. If the Update Table of Contents dialog box appears, click Update entire table, and then click OK.

5. Always save the document before you print it.
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